Contents

Chapter 1. Introduction: The Artist Media Controller .......................................................... 1
  What’s Included ................................................................. 1
  System Requirements and Compatibility .................................................. 2
  Registration ................................................................. 2
  About This Guide .......................................................... 2
  About www.avid.com .................................................. 3

Chapter 2. Setup and Installation .................................................................................. 5
  Unpacking and Elevating the MC Control ................................................. 5
  Attaching an MC Control to Additional Units .......................................... 6
  Installing Software and Hardware .......................................................... 7

Chapter 3. Common Tasks .......................................................................................... 13
  Fader Strip ................................................................. 14
  Inserts ................................................................. 14

Chapter 4. Surface Controls ...................................................................................... 17
  Power Switch ................................................................. 18
  Shift Key ................................................................. 18
  Fader Strips ................................................................. 18
  Navigation Controls .......................................................... 19
  Knobs ................................................................. 21
  Keys ................................................................. 23
  Jog Wheel and Transport Controls .................................................. 23
  CONTROL ROOM/MONITOR Knob .................................................. 24

Chapter 5. Touchscreen and Controls ........................................................................ 25
  Tracks View ................................................................. 26
  Soft Key View ................................................................. 27
  Setup Screens ................................................................. 27

Chapter 6. EuControl .................................................................................................. 31
  Surfaces ................................................................. 32
  Workstations ................................................................. 34
  General ................................................................. 35
  Preferences ................................................................. 36
  Assign ................................................................. 37
  Layouts ................................................................. 38
  Soft Keys ................................................................. 38
Chapter 7. Soft Keys ................................................................. 39
  Save .................................................................................. 39
  Revert .............................................................................. 39
  Restore .............................................................................. 40
  Section ............................................................................ 40
  Page .................................................................................. 40
  + ..................................................................................... 40
  - ..................................................................................... 40
  Soft Key Label ................................................................. 40
  Layout .............................................................................. 40
  Icon .................................................................................. 40
  Font .................................................................................. 40
  Color .............................................................................. 40
  Command ........................................................................ 41
  Jog Wheel Commands ....................................................... 43

Chapter 8. Setting the IP Address ........................................... 49
  Environmental Compliance ................................................ 51
  EMC (Electromagnetic Compliance) ..................................... 51
MC Control, MC Mix, and MC Transport comprise the Artist Series family of media controllers. They use a 100 Mbs Ethernet EUCON™ connection to control audio and video applications running on a workstation computer. EUCON is a high-speed communication protocol and enables control of virtually every application feature.

Each Artist Series media controller can run as a standalone device. Up to four MC Mixes can be used with one MC Control and/or one MC Transport to create a larger control surface. Artist Series media controllers borrow many features from the MC Pro and System 5-MC.

The MC Control supports two types of applications:
- EUCON-aware applications (such as Pro Tools™ 9.0 and higher, Cubase, Logic Pro, and Nuendo) directly support the EUCON protocol. They provide the highest level of integration, high-resolution controls, and high-speed connectivity.
- Non-EUCON-aware applications that support Mackie Control or HUI (such as Pro Tools 8.x and lower, Live, and Reason) can use many functions but are less integrated than EUCON-aware applications.

MC Control can provide some functionality over non-EUCON-aware applications that do not support HUI or Mackie Control by sending out keystroke commands over EUCON.

EuControl Software

The EuControl software application is responsible for finding, linking, and communicating with all Artist Series controllers on the network. EuControl must be installed on the computer that runs the applications you want to control before using Artist Series controllers.

What's Included
- MC Control, with riser brackets
- EuControl software installer disc
- 1 Ethernet Crossover cable
- Power supply
- MC Control Quick Setup
- Registration Information Card
System Requirements and Compatibility

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

For downloads and other Artist Series resources, visit:

www.avid.com/artistsupport

Registration

Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. By registering, you become eligible to receive the following:

- Technical support information
- Software update and upgrade notices
- Hardware warranty information

About This Guide

Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

➡️ Shortcuts show you useful keyboard or mouse shortcuts.

➡️ Cross References point to related sections in this guide and other Avid guides.
Hardware Keys on Artist Series Units

The names of keys on Artist Series hardware are in bold (such as SEL).

The SHIFT key on Artist Series hardware is indicated by bold text, in all-caps (SHIFT) to distinguish it from references to the Shift key on your QWERTY keyboard.

SHIFT and SHIFT Lock

The SHIFT key on Artist Series units is used in conjunction with other keys to access secondary functions that are labeled in blue above the primary function. MC Transport provides a single SHIFT key at the bottom-right. Two SHIFT keys are located at the bottom-left and -right on both MC Control and MC Mix.

The following terminology is used to describe SHIFT functions.

Example:

- “Press and hold the Shift key then press the AUX key”
  is written as
  “Press SHIFT+AUX/GROUP”

How to Use this PDF Guide

The Acrobat PDF version of this manual can be a valuable online resource. These are some useful features of the PDF:

- The Bookmarks on the left serve as a continuously visible table of contents. Click on a subject heading to jump to that page. Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading.
- The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns into a finger. Then click to locate to that subject and page.
- All cross references are active links. Allow the hand cursor to hover over the reference until it turns into a finger and click to follow the reference.
- Use the left and right arrow keys on the bottom bar to go back and forth between views. This is a great way to follow a cross reference and return to the page from which you were reading.
- Select the Find item from the Edit menu to search for a subject. This can be used as an “index on the fly.”
- Use the magnifying glass tool or the zoom edit box on the top bar to zoom in/out. This is helpful when examining a complex graphic or setting the text size for easy reading online.

About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your system. The following are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on the User Conference.

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

Products and Developers Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

News and Events Get the latest news from Avid or sign up for a Pro Tools demo.
Chapter 2: Setup and Installation

Unpacking and Elevating the MC Control

Unpack MC Control, its power adapter, AC power cord, Installer disc, Ethernet crossover cable, and riser brackets.

MC Control can be elevated or angled using small foldout legs on the bottom of the unit or elevated and angled by attaching the larger riser brackets. Since either method requires turning MC Control over, it is easier to do this before attaching any cables. Turn it over and place it on a soft surface.

Pull out all four of the small foldout legs to moderately elevate the unit; pull out only the back two to angle the unit towards you. Pull out the metal clips from the same area as the legs and move them until they snap into the legs.

Two larger, detached riser brackets elevate and angle the unit more than the foldout legs. Use moderate force to snap them into the bottom panel as shown.
To remove the riser brackets:

1. Slide the side panels off.

2. Press the tabs to release the riser brackets.

3. Lift the riser bracket out of the MC Control to remove.

**Attaching an MC Control to Additional Units**

An MC Control can be physically attached to up to four MC Mixes and one MC Transport to form a larger, stable control surface.

*If you are using multiple units, see “Surfaces” on page 32 to use EuControl to arrange the units in the desired order.*

To join an MC Control to an MC Mix:

1. On the MC Control, use a #2 Phillips screwdriver to remove the two silver screws. The screws may be tight, so you may have to use some force.

*Removing screws from the bottom panel*
2 Lift the black plastic connecting part and side panel up and out of MC Control.

![Removing connecting part and side panel]

3 On the MC Mix, remove the side panel on the end where it will attach to MC Control.

4 Slide the connecting part of MC Control into MC Mix to attach them together.

![MC Mix and MC Control attached by connecting at side panel]

## Installing Software and Hardware

You must install EuControl software before using your Artist Series media controller.

### To install EuControl software and your Artist Series media controller:

1. Do one of the following:
   - Download the EuControl installer for your computer platform from www.avid.com/artistsupport. After downloading, make sure the installer is uncompressed (.dmg on Mac or .ZIP on Windows).
   - or –
   - Insert the Installer disc into your computer.
2. Double-click the EuControl installer application.
3. Follow the on-screen instructions to complete the installation.

   ![If prompted to download the most current version of EuControl, follow the onscreen instructions.]

4. When installation is complete, click Quit (Mac) or Finish (Windows). EuControl will launch automatically and is running when its icon appears:

   ![Menu bar with EuControl icon]

   - On Mac, the icon is shown in your menu bar.
   - On Windows, the icon appears in the System tray (or alongside other Hidden Icons in the lower tool bar if you do not have your system configured to always show icons in the System tray).

5. Shut down your computer.
6 Plug one end of the AC power cord into the power adapter and the other into a power outlet. Make sure the AC power cord is pushed all the way into the adapter.

Connecting the power adapter

7 Connect the DC output cable from the power adapter to DC In on the left side of the rear panel.

Connecting the power adapter

8 Plug one end of the Ethernet crossover cable into the Ethernet jack (labeled with) on the rear panel of the MC Control.

Ethernet cable and rear panel jack
9 Plug the other end of the Ethernet crossover cable into an open Ethernet jack on your computer, router, or Ethernet switch.
   • Note that connecting directly to the computer may require removing your Internet cable. If you have a Mac with two Ethernet ports, use Ethernet 1, rather than Ethernet 2.

   MC Control connected directly to computer

   • An Ethernet router or switch is required to connect additional MC Mix or other Artist Series unit such as an MC Transport, or to connect units to a local area network.

10 Turn on your router (if applicable), then turn on your computer and wait until it finishes starting up.

11 Press and release the **POWER** switch on MC Control. Do the following, as appropriate for your operating system:

   **Mac** Wait up to 60 seconds. A green icon in the menu bar indicates correct installation.

   ![EUCON icon on Mac]

   **Windows** Wait up to 60 seconds. A green icon appears in the System tray (or, in Hidden Icons if your system is not configured to show all icons in the System tray).

   ![EUCON icon on Windows]
12 If you did not see the green icon, do the following:
   • See “Surfaces” on page 32 and add the MC Control manually.
   • Shut down the MC Control and your computer, then turn them on (computer first, then MC Control).
   • If your Mac is pre-2002 and you are using an Ethernet router or switch, you need to purchase a normal straight-through Ethernet cable (instead of the crossover Ethernet cable supplied) from a computer store.
   • See www.avid.com/artist/support for the most current troubleshooting information.

13 If you downloaded the latest software from the web, you may need to update the firmware on your Artist Series controllers. See “Update Firmware” on page 33 for instructions.

14 Launch your application (such as Pro Tools, Logic Pro, Cubase, or Digital Performer) and open a session or project.

15 To set up your application to work with MC Control, see the EuCon Application Setup Guide that you downloaded at the beginning of this section.

**Controlling a Second Workstation**

MC Control can control applications running on a second computer, referred to in this guide as a workstation. Most users will not need to do this because EuControl will be running on the same workstation as their audio/video applications.

**To be able to control a second workstation:**

1 Do one of the following:
   • Download the EuControl installer from www.avid.com/artistsupport onto the second computer. After downloading, make sure the installer is uncompressed (.dmg on Mac or .ZIP on Windows).
   – or –
   • Insert the installer disc into the second computer.

2 In the Extras folder, double-click the Install EuCon Workstation installer.

3 Follow the instructions to install the EuCon software.

**Connecting a Footswitch**

The MC Control has a ¼-in FOOTSWITCH input on the rear panel. The footswitch can be used to punch in and out of recording. Plug the footswitch in before powering on the MC Control. See “Footswitch” on page 37 for details.
Chapter 3: Common Tasks

If you completed the steps in Chapter 2, “Setup and Installation”, you are ready to start learning MC Control. The following important user interface items and terms are used in tasks:

- The Soft Knobs can be turned like a conventional knob and pressed like a switch to access an additional context-sensitive function (some do not have a second function).
- The Soft Knobs access a hierarchical menu system. The beginning of the menu system, called the top-level knob set, lets you choose among eight functions to control with the Soft Knobs.
- The Touchscreen has two rows of six Soft Key labels that correspond to the two rows of physical Soft Keys. Press the SOFT KEYS < and > page keys to display additional Soft Key labels.
- Press and hold the SHIFT key, found at the bottom-left and -right of MC Control, to access the functions labeled in blue.

Soft Knobs, Soft Keys, and Touchscreen

1. Soft Knobs
2. Soft Keys page keys
3. Soft Keys
4. Soft Key labels
Fader Strip

To use the fader strip:

1. Press a fader SEL key on MC Control. The corresponding track is selected in your application and highlighted on the Touchscreen.
2. Move the fader up and down.

You are now controlling the level of your track with MC Control. The top of the Touchscreen displays a level meter and other track information.

3. Press the PAN Soft Knob to access the Pan knob set.
4. Turn the appropriate Soft Knob to adjust the pan of your application's audio track. Note that this is not the same knob you pressed in step 3.
5. Press the NUDGE> key to move all four tracks over one strip. If tracks 1–4 were assigned to strips 1–4, tracks 2–5 are now assigned to strips 1–4.
6. Press and hold the SHIFT key and press the <BANK key to restore tracks 1–4 to strips 1–4. The SHIFT key accesses the functions labeled in blue, in this case the HOME function. For convenience, another SHIFT key is located at the bottom-left of MC Control.
7. Press the BANK> key to shift tracks over four at a time. If tracks 1–4 were assigned to strips 1–4, tracks 5–8 are now assigned to strips 1–4. The <NUDGE and <BANK keys perform similar operations but in the opposite direction.

Inserts

To control inserts:

1. Add a plug-in on track 1 of your application.
2. If tracks 1–4 are not assigned to strips 1–4, press and hold the SHIFT key and press the <BANK key to restore tracks 1–4 to strips 1–4.
3. Press a fader SEL key.
4. Press the BACK key until the top-level knob set is displayed on the Touchscreen.
5. Press the INSERTS Soft Knob. The names of the plug-ins on that track are distributed across the Soft Knobs.
6. Press the Soft Knob beside the desired plug-in name to select it. The plug-in parameters are distributed across the Soft Knobs.
7. Turn the Soft Knob beside the desired parameter to adjust its value.
8. Press the PAGE keys to access more parameters.
9. Press the BACK key to exit that plug-in.
Transport Keys and Jog Wheel

To use the Transport Keys and the Jog Wheel:

1. Use the PLAY, STOP, FF, and REW buttons to navigate the timeline of the edit window of your application.

2. Press the JOG key.

3. Spin the Jog Wheel clockwise and counterclockwise to move forward and backward, respectively, on the timeline.
Chapter 4: Surface Controls

MC Control has four channel strips each with a touch-sensitive fader, eight touch-sensitive knobs surrounding a 7-inch touchscreen, twelve soft keys, transport switches, a Jog wheel, and various navigation buttons. MC Control comes with an external DC power supply. Rear panel jacks include DC power input, RJ-45 Ethernet, and ¼-inch footswitch.

Surface Controls

1. Fader Strips
2. Soft Knobs rotary encoders
3. Volume
4. Navigation
5. Power
6. SHIFT
7. Soft Key navigation
8. Soft Keys
9. Transport and Job Wheel
**Power Switch**

Press and release the **POWER** switch to turn MC Control on/off.

---

**Shift Key**

The **SHIFT** key is used in conjunction with other keys to access the functions labeled in blue above the primary function. Press and hold the **SHIFT** key, found at the bottom-left and -right of MC Control, then press the other key.

---

**Locking the Shift Key**

The **SHIFT** key can be locked to access multiple alternate key functions without holding the **SHIFT** key down.

**To lock the Shift key:**

1. Press and release the **SHIFT** key quickly and then press another key to access its alternate function. Continue in this manner until finished.

2. Press and release the **SHIFT** key quickly again to restore normal operation.

   If you have another Artist Series controller connected to the same instance of EuControl as MC Control, you can also lock the **SHIFT** key by pressing two **SHIFT** keys down simultaneously. They can be on different devices. Unlock the **SHIFT** key by pressing and releasing one quickly on any device. See “My Surfaces” on page 32 for more information.

---

**Fader Strips**

MC Control provides four fader strips, each with a touch-sensitive fader, that control tracks in an audio or video application.

**Fader**

The fader controls the track assigned to this strip. It is motorized, so it reflects changes made in the application, such as automation. It is also touch sensitive, which some applications use when automating.

![Fader strip](image)

When the Select by Touch General preference is enabled, touching a fader selects that track in the application and focusses it, just like pressing the **SEL** key. (See “Preferences” on page 36.) Holding down the **SHIFT** key and touching a fader sets it to unity gain.

**ON**

The track is on (unmuted) when the strip **On** key is lit and off (muted) when the strip **On** key is not lit.
**SOLO**
The SOLO key lights red when that strip’s track is soloed and is unlit otherwise.

**SEL**
Pressing a fader SEL key selects that track in the application and focuses it on MC Control. The SEL key lights yellow when the track is selected and is unlit otherwise. All knob functions operate on the focused track.

*Some applications allow selecting multiple tracks if the Shift key on the QWERTY keyboard is held down while selecting tracks. In this case, the attentioned track is the one whose SEL key was most recently pressed.*

**ASSIGN**
Press the ASSIGN key to display the Assign tab in the EuControl Settings dialog (see “Assign” on page 37).

**REC**
Press the REC key to enable recording on a track. The REC key lights red to indicate that track is enabled (armed) for recording. Press the REC key to cancel a track enabled for recording.

*Some applications blink the REC LED when armed but not recording and light solid when recording.*

**AUTO**
To change the automation mode on a track, press the AUTO key until the desired automation mode displays on the Touchscreen.

---

**Navigation Controls**
Scroll through tracks using the BANK and NUDGE keys. HOME and END are shortcuts to the first and last banks, respectively.

![Fader navigation controls](image)

**BANK and NUDGE**
The BANK and NUDGE keys change which tracks are assigned to the strips. The four strips can be thought of as a window that moves in the direction indicated by the arrow over the tracks in the application.
<NUDGE
Moves the window one track to the left. If strips 1–4 had tracks 5–8, they now have tracks 4–7.

NUDGE>
Moves the window one track to the right. If strips 1–4 had tracks 5–8, they now have tracks 6–9.

<BANK
Moves the window one bank (four tracks) to the left. If strips 1–4 had the bank starting at track 5, they now have the bank starting with track 1. Pressing <BANK again does nothing because the first bank is already shown.

BANK>
Moves the window one bank (four tracks) to the right. If strips 1–4 had the bank starting at track 5, they now have the bank starting with track 9.

MIXER and CLOSE
Not all applications support these keys.

MIXER
Opens and closes the application’s mixer window.

CLOSE
Closes any open window or dialog box on the application.

HOME and END

HOME
Moves to the first bank with tracks 1–4 assigned to strips 1–4.

END
Moves to the last bank.

APPLICATION
Press the APPLICATION key to toggle between the two most recently used open applications. Hold down the APPLICATION key and press BANK> to toggle between all open applications in a circle. Hold down the APPLICATION key and press <BANK to cycle through applications in the opposite direction.

WORKSTATION
MC Control can control applications running on a second computer, referred to in this guide as a workstation. Press the WORKSTATION key to attach MC Control to another workstation. You must first use EuControl to create a list of workstations that this key switches between (see “Workstations” on page 34).

While attached to a second workstation, your computer keyboard and mouse can be configured to control that workstation (see “Workstations” on page 34).

Navigating Among Multiple Artist Media Controllers
The BANK and NUDGE keys perform the identical actions on the combined set of tracks.
Knobs

Eight touch-sensitive knobs surround the Touchscreen. Each is a continuously rotating knob that adjusts parameters such as pan and aux send levels. The knob has a built-in switch allowing it to be pressed from the top. This is called the Knob Top key and is typically used to access sub-menus but also to turn parameters on and off.

Knob Set Selection

A knob set is an array of knobs used by EUCON-aware applications to control plug-ins, EQs, dynamics, aux sends, and other functions. When MC Control first starts, the Top Level Knob Set is displayed on the Touchscreen, showing all eight knob sets beside the eight knobs. Press a Knob Top to select that knob set and enter the MC Control menu system.

Some knob sets can display another knob set called a sub-menu. For example, the Inserts knob set shows the names of every plug-in inserted on the track, one plug-in name per knob. Pressing a plug-in’s Knob Top key displays its parameters on the knobs for editing. This new knob set is a sub-menu of the Inserts knob set. Press the BACK key to return to the top of the Inserts knob set. Since sub-menus can be more than one level deep, this can be accomplished by pressing the BACK key repeatedly.

INSERTS

Pressing the INSERTS key displays the inserts knob set for editing plug-ins. The first plug-in is displayed on the knob. Pressing one of these Knob Tops displays the first eight plug-in parameters for editing. Pressing a Knob Top displays the plug-in parameters for editing.

EQ

Press the EQ key to display the EQ knob set to configure equalization controls and filters. This shows four EQ bands on eight knobs.

AUX

Press the AUX key to display the Aux (Sends) knob set to control auxiliary sends. The first aux send is displayed. Up to eight aux sends can be shown at once.

PAN

Press the PAN key to display the Pan knob set to configure stereo or surround panning. The stereo pan control is typically displayed. The first page of eight pan knobs is shown.

INPUT

Press the INPUT key to display the Input knob set to configure input routing, mic gains, phantom power, and other application-specific parameters.

DYN

Press the DYN key to display the Dynamics knob set to configure compressors, limiters, expanders, and gates.

GROUP

Press the GROUP key (SHIFT + AUX/GROUP) to display the Group knob set to configure group bus routing or control group (VCA) membership.

MIX

Press the MIX key to display the Mix knob set to configure output routing.
Knob Functions

Each knob has the following controls:

- Touching the knob's image on the Touchscreen toggles the state of its primary parameter, such as EQ Band 1 on or off. When on, a small green LED lights on the lower left.
- Pressing the SHIFT key and touching the knob's image on the Touchscreen toggles its secondary parameter (if it exists), such as toggling an aux send between pre- and post-fader. This can also change the knob function between two or more parameters, such as EQ Frequency and Q. When active, a small yellow LED lights on the upper left.

Knob Set Navigation Keys

Since a knob set may have more parameters than knobs, the < PAGE > keys scroll among them.

- **<PAGE>**
  - Press the < PAGE > key to scroll to the previous page. When on the first page, pressing < PAGE key does nothing. The < PAGE key lights yellow when there is a previous page to go to.

- **PAGE>**
  - Press the PAGE> key to scroll to the next page. When on the last page, pressing the PAGE> key does nothing. The PAGE> key lights yellow when there is a next page to go to.

Configuration Pages (CFG)

Many knob sets have a configuration page to set up that knob set. The configuration page for the Inserts knob set, for example, is used to assign plug-ins to a track. The configuration page for the Aux knob set assigns aux sends to a track. Some applications use the configuration page to recall plug-ins and EQs.

Press the < PAGE and PAGE> keys simultaneously to display a knob set's configuration page, if it has one. When on the configuration page, both the < PAGE keys light.

- **BACK**
  - Press the BACK key once to return to the previous knob set. Press the BACK key repeatedly to back out of all sub-menus and display the top level knob set.

- **TOP**
  - Press the TOP key to immediately back out of all sub-menus and display the top level knob set. This is equivalent to pressing the BACK key repeatedly.
Keys

MC Control supports Surface Soft Keys (discussed in this section) and Touchscreen Soft keys (see “Soft Key View” on page 27). This is one of the most powerful features of MC Control (see Chapter 7, “Soft Keys”).

Below the Touchscreen are 12 soft keys (six per row). The bottom of the Touchscreen contains labels for each soft key. Soft Key labels contain text plus an optional icon.

Soft Keys

Soft Keys are organized into pages with 12 Soft Keys per page. The page numbering starts with one and there is no limit to the number of pages. A Soft Key can be programmed to jump to an arbitrary Soft Key page, allowing creation of menus and webs of Soft Key pages. The following keys navigate through Soft Key pages:

- **SOFT KEYS ^** Go to the previous soft key page, if there is one.
- **SOFT KEYS v** Go to the next soft key page, if there is one.
- **HOME** Go to Soft Key page 1.
- **END** Go to the last Soft Key page.

Jog Wheel and Transport Controls

The Jog Wheel controls jog, shuttle, zooming, and other functions. Surrounding it are keys that control Jog Wheel functions and transport keys.

Many EUCON applications control far more functions with the Jog Wheel, such as trimming clip head and tail, setting clip gain, making cross fades, and similar functions. These functions are accessed using Soft Keys.

Jog Wheel Functions

- **JOG** Press the **JOG** key and spin the Jog Wheel clockwise and counterclockwise to move forward and backward, respectively, on the timeline. The yellow LED lights in this mode.
- **SHUTTLE** Press the **SHUTTLE** key (**SHIFT+JOG**) and spin the Jog Wheel clockwise and counterclockwise to adjust the forward and backward playback speed, respectively. The playback speed is proportional to the wheel’s position. The yellow LED lights in this mode.
- **ZOOM HORIZ** Press **ZOOM HORIZ** and spin the Jog Wheel to zoom horizontally in the application, typically for the arrange or project window time line. The yellow LED lights in this mode.
- **ZOOM VERT** Press **ZOOM VERT** (**SHIFT+ZOOM HORIZ**) and spin the Jog Wheel to zoom vertically, typically to adjust the track height or waveform in the arrange or project window. The yellow LED lights in this mode.
Transport Controls

REW
Press **REW** to rewind. This function varies with the application.

Implementations include:
- Rewind until **STOP** or another key is pressed.
- Rewind a fixed amount.
- Rewind while the **REW** key is pressed until it is released.

FF
Press **FF** to fast forward. This function varies with the application.

Implementations include:
- Fast forward until **STOP** or another key is pressed.
- Fast forward a fixed amount.
- Fast forward while the **FF** key is pressed until it is released.

STOP
Press **STOP** to stop all other functions.

PLAY
Press **PLAY** to play the project.

REC
Press **REC** begin recording at the present location. All tracks armed for recording are punched into record.

CONTROL ROOM/MONITOR Knob
Turn the **CONTROL ROOM** knob to adjust the volume of the control room. The knob controls either Studio Monitor Express or an application that supports a EUCON monitor section.

Press the **CONTROL ROOM** Knob Top key to mute the control room volume. Press it again to unmute.

Turn the **MONITOR** knob (**SHIFT + CONTROL ROOM**) to adjust the volume of Monitor A, commonly used as a headphone volume.

Press the **MONITOR** Knob Top key to mute the monitor volume. Press it again to unmute.
Chapter 5: Touchscreen and Controls

MC Control has a wide aspect ratio Touchscreen mounted in its center.

The Touchscreen always shows the following:

1 **Knob Displays** Show the current knob function for their corresponding knob. There are four on each side of the Touchscreen.

2 **Info Area** Shows the application and workstation name, the primary and secondary time code displays, or the attentioned track name. Touch this area to switch between them.

3 **Channel Strip Displays** Shows the tracks assigned to the channel strips. The attentioned track is underlined in yellow.

4 **Soft Key Labels** Shows an optional icon followed by a text label for each of the 12 Soft Keys underneath the screen.

5 **Menu Bar** Displays the Tracks view, Soft Key view, or Setup Screens on the Touchscreen. The center of the screen changes to reflect the selected Menu view.
Tracks View

Tracks view shows up to 32 tracks at a time so quickly mute, solo, arm, and select tracks that are not banked to the faders.

**Track View**

Select an operation on one of the four circular buttons on the left and then touch one or more of the square track buttons to perform that operation on the selected tracks. Touch a selected track button again to deselect it.

**SOLO** A yellow circle surrounding an S on the lower left of the track rectangle shows the track is soloed.

**REC** A red circle around the track number in the lower right shows the track is armed to record.

**MUTE** A dark grey button shows the track is muted.

**SEL** The track’s rectangle is highlighted in yellow to show it is selected. The last track selected is attentioned.

The ^ and v keys scroll down/up one line of eight tracks, if there are more lines of tracks in the project. Press the **SHIFT** key on MC Control or the workstation keyboard and touch one of these buttons to scroll up or down a full page (32 tracks). The track scroll arrow buttons are disabled if there are no further tracks to display.
Soft Key View

This view displays 24 Touchscreen Soft Keys in four lines of six each.

▼ Scrolls forward to the next page of Soft Keys (unless on last page).

▲ Scrolls back to the previous page of Soft Keys (unless on page 1).

Touch a Soft Key to execute its function. See Chapter 7, “Soft Keys” to learn how to customize Soft Key pages and create your own Soft Key functions.
**Setup Screens**

Less commonly used functions are found on the following Setup Touchscreens. The Soft Keys navigate through them. The top-right Soft Key is Exit, which returns to the Touchscreen last used.

**Control Room**

The Control Room Touchscreen selects the source of the control room volume knob, and provides talkback, dim, and mute functions. This is typically used to control Studio Monitor Express but can also control EUCON monitor sections if an application supports it.

![Control Room Touchscreen](image)

**Control Room Source** Shows the possible sources to the control room volume control. The v and ^ arrow buttons scroll through sources if there are more than four. Touch to select the desired source, which is highlighted.

**Talk** Engages the talk function, which is typically used to talk to talent in a different room. The button lights up when talk is engaged, even if engaged from the application or Studio Monitor Express graphic user interface (GUI).

**Dim** Dims the control room volume (lit when dim is active).

**Cut** Mutes the control room volume (lit when cut is active).
**Monitor**

The Monitor Touchscreen selects the source of the monitor volume knob or mutes monitor A. Holding down **SHIFT** and turning the control room knob changes the volume of Monitor A in Studio Monitor Express or the attached application if it supports a EUCON monitor section.

**Setup: Monitor**

**Monitor Source** Lists the possible sources to the monitor volume control. The up and down arrow buttons scroll through sources if there are more than four. Touching one of the sources highlights it and makes it the current monitor source.

**Cut** Mutes the monitor volume (lit when cut is active).
Chapter 6: EuControl

EuControl is launched automatically upon starting your computer and runs in the background. EuControl is responsible for finding, linking, and communicating with all Artist Series media controllers on the network. EuControl’s configuration tasks are accessed by clicking the green icon on the taskbar (Mac) or in the Hidden Icons view (Windows) and selecting EuControl Settings.

Accessing EuControl Settings

To open the EuControl Settings window:

- Do one of the following:
  - On Mac, click the green icon on the taskbar and select EuControl Settings.
  - On Windows, click the green icon in the Task or System tray (Windows) and select EuControl Settings. Unused icons are shown in the Hidden icons view.

Only one instance of EuControl can run on a workstation. However, multiple workstations on a single network can each run EuControl. Each instance of EuControl can connect an MC Transport, an MC Control, and up to four MC Mixes on the network. These multiple devices act together as a single control surface. Once connected, these Artist Series media controllers are not available to other instances of EuControl until relinquished.

The tabs are discussed in the order (left to right) they appear at the top of the EuControl Settings dialog.

💡 Some EuControl features pertain only to the MC Mix and MC Control, not the MC Transport. These are called out at the beginning of each tab’s section.
Surfaces

The Surfaces tab shows all Artist Series media controllers on your network and those connected to your instance of EuControl.

**Control Unit Banks Independently**

This option is only available when an MC Control is selected in the My Surfaces list. When enabled, each Artist Series unit can bank independently of each other. In applications that support it, this lets you configure one unit for dedicated control of output busses, for example.

**All Surfaces**

All Surfaces shows all Artist media controllers on the network. A device shown in light gray is already connected either to your own or another instance of EuControl running on a different workstation. In both cases, it is not selectable.

**My Surfaces**

My Surfaces shows the Artist media controllers connected to your instance of EuControl. There can be one MC Control, one MC Transport, and up to four MC Mixes in the My Surfaces list, linked into a single large surface.

The top-to-bottom order corresponds to the left-to-right order of the surfaces, respectively. The left-most surface has fader number 1. Use the up and down buttons (to the right of the My Surfaces list) to reorder the list.

Each Artist Series controller can be renamed by double-clicking the existing name and typing a new name.

**Add**

Click Add to add the selected All Surfaces entry to My Surfaces. This connects this Artist Series controller to your instance of EuControl. You can also click and drag an Artist media controller from All Surfaces to My Surfaces.

Add is disabled if all Artist media controllers in All Surfaces are connected to any instance of EuControl.
**Remove**

Click Remove to remove the selected surface from My Surfaces and make it available to other instances of EuControl.

Remove is disabled if no surface is selected.

**Automatically Add**

The Automatically Add menu has two settings that control what happens to stored Surfaces between shutdown and startup.

**All Surfaces (default)** This setting is best used when you are the only person running EuControl in your home or studio. It provides an easy plug-and-play experience by automatically adding your All Surfaces list to your My Surfaces list so you never have to manually edit the My Surfaces list.

**My Surfaces Only** This setting is useful in facilities where other EuControl users are on your network. When EuControl starts, only the surfaces from your My Surfaces list are added. Because a surface can only be claimed by one user at a time, this avoids claiming another user’s surfaces.

**Update Firmware**

Each time a new version of EuControl is installed, each MC Transport, MC Control, and MC Mix in your system may need its firmware updated. The firmware is embedded in EuControl so an Internet connection is not required.

**To update firmware:**

1. Select each Artist Series controller in the My Surfaces list (Shift-click to select multiple devices).
2. Click Update Firmware to update their firmware. If a dialog displays a message that the firmware is up to date, no further action is necessary.
3. Follow the instructions in the EuControl dialog box. While updating firmware, observe the following:
   - The Artist Series controllers must be plugged into a working power source.
   - Do not power off any units during the update or attempt to interrupt the update.
   - The status for each unit being updated is displayed on that device as well as in the EuControl dialog box.

**Show Info**

Select an Artist media controller and click Show Info to display the name, and hardware and software information on-screen.
Workstations

An Artist Series controller can control applications running on a second computer, referred to in this guide as a *workstation*. The Workstations tab establishes the list of workstations that the WORKSTATION key cycles through. Any workstation running EUCON software can be in this list, including those controlled by the System 5-MC, MC Pro, and MC Control.

![EuControl Settings](image)

**Workstations tab**

**All Workstations**

All Workstations lists all EUCON-enabled workstations on the network. If the workstation is already in the My Workstations list, it is shown in gray and cannot be selected.

**My Workstations**

My Workstations lists the workstations that can be attached to by pressing the WORKSTATION key.

It is possible to put a workstation in the My Workstations list that is already attached to another instance of EuControl running on another computer. It cannot be attached here until it is unattached from the other instance of EuControl. This was done to allow multiple users to share workstations without having to frequently edit their My Workstation list.

**Add**

Click Add to add the selected workstation from the All Workstations list to the My Workstations list. If the workstation is already in the My Workstations list, it is gray and cannot be selected.

**Remove**

Click Remove to remove the selected workstation from the My Workstations list.

**Attach/Detach**

Select a workstation in the My Workstations list and click Attach. A check mark appears in the Attach column next to that workstation. This workstation is now communicating with the Artist media controller(s) connected to your instance of EuControl.

If the selected workstation is already attached, the button displays Detach.
Redirect Keyboard and Mouse Control toAttached External Workstation

Your computer keyboard and mouse can control a second external workstation, if desired. Select this option to redirect keyboard and mouse control to the attached workstation. Note that the keyboard and mouse will no longer control your primary workstation. If this option is not selected (default setting), your keyboard and mouse control your primary computer.

You can manually toggle control back and forth between your primary workstation and the attached external workstation by pressing Control+Option+\ (Mac) or Control+Alt+\ (Windows).

The Redirect Keyboard and Mouse Control to Attached External Workstation option must be checked before adding the workstation to the My Workstations list. If it is toggled ON after adding the workstation it will have no affect. Only workstations added with the option checked will respond.

General

This tab controls how the Artist media controller and application software work together.

![General tab](image)

**Workstation Tracks Knob Set Changes**

Lets supported workstations follow selection of knob sets on the Artist Series unit.

**Open Plug-ins on Workstation When Editing**

Lets supported workstations open plug-in windows on-screen when a plug-in is selected for editing on an Artist Series unit.

**Close Plug-ins on Workstation When Exiting**

Lets supported workstations close plug-in windows on-screen when you press BACK or exit Inserts mode on an Artist Series unit.

**Select by Touch**

Lets supported workstations attention (focus) tracks on-screen when their fader is touched on Artist Series units.

**Auto-bank to Selected Track**

Lets Artist Series units bank to tracks when the tracks are selected on-screen.
Display Track Numbers on Surface

Lets Artist Series units show track numbers as assigned by the current workstation (if supported).

Solo Mode

Lets you configure Artist Series units for the following Solo modes as (if) available in the current workstation:

- Solo-in-Place
- After-Fader Listen (AFL)
- Pre-Fader Listen (PFL)

See the documentation for your specific workstation for details on Solo modes.

Wheel Sensitivity

The sensitivity of the Jog Wheel and Shuttle Ring can be precisely adjusted using these sliders. The top two sliders pertain to the MC Transport, the bottom is the Jog Wheel for the MC Control.

The center position is the default for each control. Click and drag a slider to move it right for faster response or left for a slower, more controlled movement. Click the Reset button to restore the center position.

Preferences

MC Mix and MC Transport Display Screen Dim Time

This slider only affects MC Mix and MC Transport.

MC Control Display

This slider adjusts the brightness of the MC Control Touchscreen.
**Footswitch**

MC Control lets you connect a footswitch for hands-free punch in and out. Connect a footswitch to the 1/4-inch FOOTSWITCH input on the back panel.

**To configure the Footswitch in EuControl:**

- In the Footswitch section of the Preferences tab, click to select the desired Punch In and Punch Out assignments:

  **Record | Record**  When the application is rolling, pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again takes the track(s) out of record but does not stop the transport.

  **Record | Play**  Pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again stops the record pass (your DAW may or may not automatically take the track out of record on stop; see the documentation for your application).

  **Status**  Shows whether the footswitch state is currently on or off.

**Shift + Fader Sets Level to 0dB**

When enabled, holding SHIFT and touching a fader sets the fader to 0dB. SHIFT-lock does not apply (SHIFT must be pressed).

---

**Assign**

This tab manages how tracks are assigned to strips on the MC Control or MC Mix. By default, tracks are automatically assigned in banks of four.

**Display Application’s Track Numbers**

Enabling this checkbox lets EuControl display track numbers as assigned by the currently selected (in focus) application, if that application supports track numbers.

**Clear All Assignments**

Clears all currently displayed assignments.
**Lock to Application**

This feature allows the transport controls and/or the entire surface to stay locked to the application listed at the top-left of the dialog even when that application is not focussed.

**Entire Surface** Select this checkbox to lock the entire surface, including those of all linked Artist media controllers, to the listed application.

**Transport** Select this checkbox to lock the transport controls (MC Mix and MC Control) to the listed application. All of the MC Transport’s controls are locked when selected.

**Monitor and Control Room** Locks the Monitor and Control Room controls to the listed application.

---

**Layouts**

Use the Layouts tab to store and recall assignments. For example, you can use the Assign tab to “lock” important tracks to specific faders, so they ignore banking. You can save that assignments as part of a Layout, so that you can easily switch between your “bank safed” layout and default banking, or other assignments.

![Layouts Tab](image)

---

**Soft Keys**

This tab controls assignments and programming for all MC Control keys (including the Jog Wheel, Shuttle Ring, and Numeric Pad), not just the six Soft Keys.

Chapter 7: Soft Keys

This tab controls Surface and Touchscreen Soft Key assignments. The only difference between them is that the Surface Soft Keys are accessed by the 12 circular buttons below the Touchscreen, while the Touchscreen Soft Keys are accessed from the Soft Keys Setup Touchscreen (see “Soft Key View” on page 27).

The application listed in the upper left of the window is called in focus because it:
- Is controlled by MC Control
  - and –
  - Receives computer keystrokes and mouse events.

MC Control can control many applications, each with its own Soft Key assignments. Since MC Control responds dynamically as the focussed application changes, you may see the Soft Keys assignments change in EuControl. Switch the focus back to the desired application and then switch back to EuControl to restore them. Although an application’s unsaved Soft Key edits are preserved between focus changes until you quit the application, it is recommended that you save your session or project frequently.

Be sure to check that the proper application is in focus before using Save, Restore, or Revert.

---

**Save**

Click Save to permanently store any changes in assignment and/or function to the Soft Keys. Changes are retained even without clicking Save until you quit EuControl.

---

**Revert**

Click Revert to revert to the Soft Key assignments since the last Save command. This discards any changes made since EuControl was last started.
## Restore
Click Restore to restore the Soft Key assignments to the factory default settings.

## Section
Click the Section popup menu to select the Soft Key type to edit: Touchscreen or Surface. The Touchscreen Soft Keys appear on the MC Control's Touchscreen and are executed by touch. The Surface Soft Key labels appear on the Touchscreen below the menu bar and are executed by pressing their corresponding circular keys below the Touchscreen.

## Page
Select the Soft Key page to view and edit from the Page pop-up, or use the arrows beside the menu to increment/decrement the page by one.

### +
Click the Plus key (+) to add a new page of Soft Keys after the last page. There is no limit on the number of Soft Key pages.

### -
Click the Minus key (-) to delete the currently displayed page of Soft Keys.

## Soft Key Label
Select a Soft Key (its outline highlights yellow) and type a label in this text field.

## Layout
Select Text Only, Icon Only, or Text and Icon from the Layout popup menu.

## Icon
Click the Icon button and select an icon from the dialog.

## Font
Click the Font button and select a font from the dialog.

## Color
Click the Color button and select a color from the dialog.
**Command**

Select a Soft Key (its outline highlights yellow) and click Command to view or edit the command(s) assigned to that Soft Key.

**Command Editor**

The figure above shows a EUCON Key Command that sets a right locator marker. The type of command is set in the left column (under Details). The center column shows the type of Key Command (Global Command). The specific Global Command is selected in the right column (Set Right Locator).

**Key**

Key commands can execute menu commands, other application-specific commands that have key equivalents, and even inject a specific text string if necessary. Key commands can also be used to make a macro, which consists of multiple commands executed sequentially by one Soft Key.

**Key Command dialog**

Type keystrokes into the text field in the Details pane. Use the Control, Shift, Opt/Alt, and Command/Start modifiers along with the Insert Special menu to finish creating the key command.
Select Repeat to repeat the command if the Soft Key is held down. For example, if the key executes a Nudge command and Repeat is selected, holding down the Soft Key will continue to Nudge.

Click Delete to delete the selected command.

**EuCon**

The EuCon command types under the Details column are specific to each application. Each application supports many EuCon commands. Browse them to determine the most useful commands for your projects. Consult the application’s documentation for specific questions about the commands. Non-EuCon-aware applications that do not support HUI or Mackie Control do not have EuCon commands.

The width of the three right columns can be changed by clicking and dragging at the bottom of the scroll area.

**Page**

The Page command configures a Soft Key to jump to a specific Soft Key page. Select Touchscreen or Surface from the Section menu, and then select Next Page, Previous Page, or Jump to Page from the Action menu. The Page field, active only when Jump to Page is selected, specifies the Page number.

**MC**

The primary function of the MC command type is to recall a Layout (see “Layouts” on page 38). Select Recall Layout from the Action menu and select the Layout number from the Layout menu. The other commands are for compatibility with MC Pro and are not used with MC Control.
Create a New Soft Key

The Record command is created in the default application set for most, if not all, applications. This section shows how to create a new Soft Key using the Record command as an example.

To create a new Soft Key:

1. Select Touchscreen or Surface from the Section pop-up menu.

2. Select a blank key and click Command.

3. Select Add > EuCon.

4. Select Transport Controls from the left column. EuCon commands automatically label the button but do not select an icon.

5. Select Record from the middle column. The completed Record command appears in the command list.

Creating a command in the Soft Keys tab

Jog Wheel Commands

The Jog Wheel can be assigned different commands than the typical jog and shuttle functions using additional Wheel Commands. It is important to note that there are two steps:

- The desired Wheel Command must be selected and assigned to a Soft Key.
- That Soft Key must be pressed to invoke the function.

The following examples demonstrate this process. These examples use Logic Pro so the dialogs for your application may look different.

Be careful because these examples can overwrite a useful Soft Key if you click the Save button. When finished, click Restore to restore the Soft Key assignments to the state they were in before you edited them. If you did click Save, you can revert to the factory default assignments by clicking Revert.
**Custom Jog Command**

Turning the Jog Wheel can insert key strokes into an application. This example inserts up and down arrows when the wheel is turned left and right, respectively. In most audio applications, this scrolls through the displayed tracks.

**To create a custom Jog command:**

1. Select Wheel from the Section pop-up menu.

   *Note that you must select the MC Control wheel icon.*

The Soft Key Wheel window opens.
2 Double-click the Jog label. The Jog Wheel Command Editor opens.

3 Click the + and enter arrow keys as the name for the command. Note that the lower pop-up is set to Turn Jog Right. The Jog Wheel must be programmed to turn right and left.

4 Select the Key command type from the Add pop-up menu.

5 Select Down Arrow from the Insert Special pop-up menu. You have assigned the command for the Jog Wheel to turn right, now assign it to turn left.

6 Select Turn Jog Left and select the Key command type from the Add pop-up menu.

7 Select Up Arrow from the Insert Special pop-up menu.

8 Close the Jog Wheel Command Editor. You can now select a Soft Key to press to assign it to the Jog Wheel.
To assign a Soft Key to the Jog Wheel:

1. Select MC Control Surface from the Section pop-up. The Soft Keys dialog opens.

2. Find a blank Soft Key and double-click it. You may need to select a different (or new) page to find a blank key. The Soft Key Command Editor dialog opens.

3. Select the Wheel command type from the Add pop-up menu.

4. Select MC Control’s Jog from the Wheel pop-up menu. Make sure to select MC Control’s Jog (bottom) and not MC Transport’s Jog (top). Icons beside their labels make this clear.

5. Select Function > Custom > arrow keys.

6. Close the Soft Key Command Editor.

7. Press the Jog Soft Key and spin the Jog Wheel to experiment with the new Wheel command. To set the Wheel Sensitivity to suit your needs, see “Wheel Sensitivity” on page 36.
Assignable Knob

In some applications, the Jog Wheel can control knobs and sliders. Some applications require clicking on the control while others allow the cursor to hover over it.

To assign the Jog Wheel to an Assignable Knob:

1. Select MC Control’s Surface from the Section pop-up. The Soft Keys window opens.

2. Find a blank Soft Key and double-click it. The Soft Key Command Editor opens.

3. Select MC Control’s Jog from the Wheel pop-up menu. Make sure to select MC Control’s Jog (bottom) and not MC Transport’s (top). Icons beside their labels make this clear.

4. Select Assignable Knob from the Function pop-up menu.

5. Close the Soft Key Command Editor.

6. Press the Jog Soft Key to use the Assignable Knob function with the Jog Wheel.
Chapter 8: Setting the IP Address

Most MC Control users will never have to set a static Internet Protocol (IP) address but in the rare cases that require it, use the instructions in this section.

Normally MC Control uses Dynamic Host Configuration Protocol (DHCP) to obtain its IP address, typically from a router. MC Control reverts to link-local addressing to generate an IP address if a DHCP server is not found on the network, such as when an MC Control is connected directly to a computer with an Ethernet cable. Both of these methods of obtaining IP addresses can be overridden by supplying a static IP address, which MC Control uses in all cases when powered on.

⚠️ Attempt this only if you have prior experience configuring a network.

To set a static IP address:

1. While holding down both $\langle$PAGE$\rangle$ keys simultaneously, press and release the POWER button. The Network Setup screen appears on the Touchscreen.

![Network Setup Touchscreen with Use DHCP selected](image)

2. Touch the parameter labeled Use DHCP (Obtain IP Address automatically). This deselects the parameter and displays the IP Address and Subnet Mask fields on the Touchscreen.
3 Touch the first box of the IP Address field. Adjust its value by turning any of the eight knobs or the Jog Wheel.

4 Use this technique to adjust all values of the IP Address and the Subnet Mask fields. Touch the Cancel button to cancel changes made to the IP address at any time.

5 Touch the OK button to save this static IP address.

6 Power MC Control off and on to use the new IP address.
Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Proposition 65 Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply. See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

EMC (Electromagnetic Compliance)

This model MC Control complies with the following standards regulating interference and EMC:
- FCC Part 15 Class B
- EN 55022 Class B
- EN 55024 Class B
- AS/NZS CISPR 22 Class B
- CISPR 22 Class B

FCC Compliance for United States

Radio and Television Interference

Communication Statement

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Any modifications to the unit, unless expressly approved by Avid, could void the user’s authority to operate the equipment.
Australian Compliance

Canadian Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance
(EMC and Safety)

Avid is authorized to apply the CE (Conformité Européenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC and Low Voltage Directive 2006/95/EC.

Safety Compliance
This equipment has been tested to comply with USA and Canadian safety certifications in accordance with the specifications of UL Standards: UL60950-1:2007, 2nd Edition and canadian CAN/CSA C22.2 60950-1-07, 2nd Edition. Avid Inc. has been authorized to apply the appropriate UL and CUL mark on its compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this equipment near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.
11) Only use attachments/accessories specified by the manufacturer.
12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.
13) Unplug this equipment during lightning storms or when unused for long periods of time.
14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.
15) For products that are a Mains powered device: The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.

16) For products containing a lithium battery: CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.

17) For products with a power switch: The main power switch is located on the top panel of MC Control. It should remain accessible after installation.

18) The equipment shall be used at a maximum ambient temperature of 40° C.